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ROHM EVK SW User’s Guide 

The ROHM EVK Platform is an easy-to-use platform that allows evaluation of ROHM products. It supports multiple Host Adapters 

and connectivity methods including RKX-A3-EVK-001 which uses CY8CKIT-059 Prototyping Kit or Arduino Uno R3 as a Host 

Adapter. RKX-A3-EVK-001 is a highly configurable adapter board that provides an easy-to-use hardware interface for a variety of 

ROHM products in a plug-and-play fashion. 

The ROHM EVK GUI SW, a powerful Windows-based desktop application, is an evaluation kit software that provides an intuitive 

Graphical User Interface capable of displaying and logging the real-time product’s data and configuring the product functions 

through a graphical register editor. This user guide describes usage of the ROHM EVK GUI SW. For the ROHM EVK HW, please 

refer to the ROHM EVK HW User’s Guide. 

 
1. Acronyms 

ADC A/D Converter 

GUI Graphical User Interface 

MCU Micro Controller Unit 

ODR Output Data Rate 

PSoC Programmable SoC (System on Chip) 

WU Wake-Up 

CRC Cyclic Redundancy Check 

 

2. Definitions 

ROHM EVK Platform Provides the full range of software, hardware and the firmware used for product evaluation 
purposes 

ROHM EVK SW The software for product evaluation purposes consists of ROHM EVK GUI SW and ROHM EVK 
FW 

ROHM EVK GUI SW ROHM Product evaluation software with a graphical user interface running on Windows OS 
ROHM EVK FW Proprietary firmware running on microcontroller-based host adapters 
ROHM EVK HW ROHM EVK EVB connected for example to RKX-EVK-001 board 
RKX-EVK-001 RKX-A3-EVK-001 + CY8CKIT-059 Prototyping Kit 
RKX-A3-EVK-001 Adapter board designed to interface with the ROHM EVK Evaluation Board and Host adapter board 
Accelerometer EVB Evaluation board with an accelerometer 
ADC EVB Evaluation board with an ADC 

ROHM EVK Host adapter 
board 

Refers to MCU board hardware that connects computer systems to peripheral devices. The host 
adapter board requires firmware for communication between the host adapter board and the 
computer 

ROHM EVK EVB Evaluation board having ROHM Product 
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4. Introduction 

Reliability is a paramount property in integrated circuits (ICs), sensors, Power Management Integrated Circuits (PMICs) etc. During 

product development, powerful tools for testing and debugging are needed. Many enterprises also need a specific environment 

tailored to the unique needs of their products to verify correct behavior. Highlighting the features and properties of developed 

products also requires a separate application developed for the purpose. Engineers at ROHM noticed that a generic platform 

capable of utilizing commonly available MCU boards as a Host Adapter can fulfill those needs.  

ROHM EVK Platform offers a single application with graphical user interface (ROHM EVK GUI SW) and multiple MCU board 

options to control various ROHM products such as sensors, LED drivers, PMICs etc. A particularly advantageous feature of the 

ROHM EVK GUI SW lies in its modular distribution and update mechanism. When users need to evaluate a newly supported 

ROHM product, they are not required to reinstall or manually update the entire software package. Instead, users can simply add 

a product family key, (6.1) which dynamically integrates the new product into the existing software framework. In such a case 

there is no need for reinstallation of the whole EVK GUI SW as typical of software products. Various demo environments can be 

easily built on top of the ROHM EVK GUI SW. Because of its versatile use, the ROHM EVK GUI SW is used by people in various 

responsibilities and technical expertise from product development, quality control and marketing. 

The contents of this user guide can be divided into two parts. Chapter 5 allows users to get quickly started with ROHM EVK GUI 

SW while Chapters 6 to 9 contain more detailed and advanced subjects. Chapter 5.4 gives a list of the most common ways to use 

the GUI. In Chapter 7 the main components of the ROHM EVK GUI SW, namely menu bar, tabs, status bar and pop-up windows 

are gone through. The ROHM EVK GUI SW is usually used in conjunction with the ROHM EVK firmware. (8) Firmware updates 

can introduce new features, and the procedures for these updates, along with solutions to common GUI issues, are detailed in 

Chapter 8.  

 

5. First time set-up 

ROHM EVK GUI SW with latest ROHM EVK FW and User’s Guide can be downloaded from the website Accelerometer Evaluation 

Kit (rohm.com). 

 

Figure 1 ROHM EVK SW download page 

https://www.rohm.com/support/accelerometer-evk-support
https://www.rohm.com/support/accelerometer-evk-support
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5.1. Installation 

After the Install package is downloaded the installation can be started, as normally, by double clicking the installer file  

“ROHM_EVK.exe”.  

After accepting the license, the installation begins. The default, and recommended, installation location is 

%USERPROFILE/Documents/ROHM_EVK  

After Installation, the ROHM EVK GUI SW startup icon can be found from the desktop (Figure 2) and from the start menu. 

(Figure 3)  

 

Figure 2 ROHM EVK GUI SW icon 

 

Figure 3 ROHM application folder in the start menu of Window 10 

 

5.2. Quick start instructions 

The following steps describe how to quickly take RKX-EVK-001 (Figure 4) with digital accelerometer quickly in use. 

 Install and set up the software as described in Chapter 5.1. 

 From the Board menu, select “RKX-EVK-001 / Accelerometer EVB / I2C”. The status of ROHM EVK GUI SW in the 

Sidebar is “EVK Disconnected”. (Figure 5) 

 From “RKX-A3-EVK-001 info” tab, confirm that the EVB corresponds to the image and EVB is configured as instructed 

in the image. (Figure 35) 

 Connect RKX-A3-EVK-001 to PC with USB cable (Figure 4) and wait for the status of the ROHM EVK GUI SW in the 

Sidebar to become “EVK Connected”. (Figure 5) This indicates that ROHM EVK GUI SW has a connection with ROHM 

EVK FW. 

 From the Sidebar (7.4.1), press “Confirm board” button (Figure 5). This will initialize ROHM EVK FW and the ROHM 

Product on the EVB. Wait for the status of the ROHM EVK GUI SW in the Sidebar to become “EVK Ready”. (Figure 5) 

 Click “Register editor” tab and select the ROHM product, (Figure 8) which is on the EVB, from the “Device name” pull-

down menu. 

 Registers of the selected ROHM product are shown the same way as in the data sheet. At this point it is possible to apply 

read and write operations to any register and parameter of the product. 
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Figure 4 RKX-EVK-001 connection to PC 

 

 

Figure 5 ROHM EVK GUI SW connection status 

5.3. First time product family selection 

The ROHM EVK GUI SW is designed to work with a wide range of ROHM products, including sensors, LED drivers, and more. 

To ensure you have the right tools for evaluating your specific product, you will be prompted to choose a product family when you 

launch the software for the first time. By choosing the product family, the software will narrow down the product range to those 

under evaluation. For example, if "Sensor and AFE" is selected, the software will focus on products related to sensors and AFE, 

displaying only the features and settings relevant to those product types. Once the appropriate product family is selected, the 

ROHM EVK GUI SW will be ready for you to begin evaluating your specific ROHM product. 

 

Figure 6 First time startup and product family selection dialog 
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The Product Family selection can be changed any time when ROHM EVK GUI SW is used. (6) Detailed explanation of product 

family selection functionality is in Chapter 7.1.4.1. On the first-time set up, click “Select” button to use found configuration files. If 

an update is available, you can use the “Update” button.  

5.4. List of common use cases 

Selecting product information  Chapter 7.1.4.1 Reconfigure Product Family 

Updating the product family Chapter 7.1.4.1 Reconfigure Product Family 

Selecting product Chapter 7.5 Product information tab 

Editing register values Chapter 7.6 Register editor 

Continuous monitoring of register values Chapter 7.6.2 Register polling 

Oscilloscope view of the data Chapter 7.7.2 Plotter view 

Logging data to a file Chapter 7.7.1 Operations in Plotter toolbar 

 

6. Product family 

Product information is organized into groups known as product families. These product families ensure the software focuses only 

on the relevant products. 

A predefined set of product families is included during the installation. However, product families can be updated or added without 

reinstalling the software.  

All updates and additions are performed using the Reconfigure product Family dialog (7.1.4.1). 

 Online update: Requires an internet connection (6.1)  

 Offline update: if no internet connection is available, product information can be added from a zip file (6.2)  

The ROHM EVK GUI SW allows switching between product families, provided their configuration data has already been added. 

To add a new key for a product family, follow the instructions in 6.1 

6.1. Product family key 

To add a new product family key, open the Product Family Selection dialog from the “Settings” menu and click the “Add” button. 

This will open a file dialog where you can browse to the location where you saved the product family key, which may be provided 

specifically for product evaluation. After selecting the key file, the corresponding product family will appear in the list within the 

dialog and can then be selected for use. Alternatively, you can drag and drop the product family key file directly into the list area 

of the dialog. Please note that an active internet connection is required to complete the reconfiguration process. 

6.2. Offline usage 

This functionality is especially useful in environments where internet access is restricted due to security policies, limited access 

to Google services, or complete lack of connectivity. To add a product family configuration from a provided ZIP file, open the 

Product Family Selection dialog from the “Settings” menu and click the “Add” button. This will open a file dialog where you can 

browse to the location where the configuration ZIP file has been saved. After selecting the file, the associated product family key 

and configuration will appear in the list and can be selected for use. Alternatively, you can drag and drop the ZIP file directly into 

the dialog list area to add it. 
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7. ROHM EVK GUI SW 

The ROHM EVK GUI SW provides generic functionality for evaluating a variety of ROHM products with unified user interface. 

Some parts of the user interface are always visible, and some of the functionality is under tabs. Since all tabs are dockable it is 

also possible to view and use several tabs at same time (Figure 7). The main components of the ROHM EVK GUI SW are the 

following: 

 Menu bar. (7.1) 

 Title bar. (7.2) 

 Status bar. (7.3) 

 Sidebar. (7.4) 

 Product information tab. (7.5) 

 Register editor tab. (7.6) (Figure 8) 

 Plotter tab. (7.7) (Figure 9) 

 Event View panel. (7.8) 

 Pop-up windows. (7.9) 

Additionally, there can be product specific functionality in the menu bar and in the Sidebar. (7.4.3) (Figure 10)  For advanced use, 

several operations can also be achieved with keyboard shortcuts. (7.10) 

 

 

Figure 7 ROHM EVK GUI main view 

 

 

Figure 8 ROHM EVK GUI register editor tab 
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Figure 9 ROHM EVK GUI plotter tab 

 

Figure 10 Product specific operations in menu bar and sidebar 

 

7.1. Menu bar 

Most of the functionality of the ROHM EVK GUI SW is accessible from the menu bar. (Figure 11) 

 

 

Figure 11 ROHM EVK GUI menu bar 

7.1.1. File 

Selecting Exit from “File” menu will close the ROHM EVK GUI SW. 

7.1.2. Data 

The “Data” menu contains the options related to acquiring the data.  

 “Streaming” corresponds to same operation as “Streaming” button in Plotter tab. (Figure 44) 

 “Logging” corresponds to same operation as Recording button in Plotter tab. (Figure 44) 
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The ROHM EVK GUI SW connects to most Host Adapters, including the RKX-EVK-001 via a USB COM port. The Bluetooth 

connection (Windows BLE) is reserved for other Host Adapters supported by the ROHM EVK. When “Settings/Auto connect USB” 

menu item (7.1.4) is enabled, the USB connection is automatically established when a compatible Host Adapter with ROHM EVK 

FW, for example the RKX-EVK-001, is connected. The connectivity options in the “Connection” menu are based on what is 

supported by the selected EVB in the “Board” menu. The ROHM EVK GUI SW remembers the type of last used connection. 

NOTE: Changing connection may take a while, please be patient. 

NOTE: If there is a problem with the connection, “CTRL+R” can be used to refresh the connection. 

7.1.3. Registers 

The “Registers” menu contains the functionality related to Register Editor (7.6) and how values in the Register Editor are load/save 

from/to file or read/write the connected EVB. 

 Load register configuration from file: Load pre-saved register values into register editor. ROHM EVK GUI SW confirms 

that pre-saved values are from same part number which is currently active in the register editor. 

 Save register configuration to file: Save part number and current values from the register editor to file. 

 Read all values from IC: Corresponds to same operation as “Read all” button in (7.6.1).   

 Write all values to IC: Corresponds to same operation as “Write all” button in (7.6.1). 

 Dump register values to file: Save part number and current values from the register editor to human readable text file. 

(Figure 12) 

 Open register map definition: This allows the user to load any register definition file from any directory using the file dialog 

to the register editor.  

 Verify write: If enabled, register value is read back and verified after each register editor write operation. Success and 

failure are indicated in the register editor’s register specific status field. (Figure 40)  

NOTE: Some ROHM products change register value right after it is written. For such products, this operation is bypassed 

automatically. 

 

 

Figure 12 Partial snapshot of the KX132-1211 register dump 
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7.1.4. Settings 

 The “settings” menu (Figure 13) contain various connectivity and functionality settings. 

 Auto connect USB: Connection is established automatically to first USB connected ROHM EVK Host Adapter. 

 Auto config and registers download: When enabled, the ROHM EVK GUI SW will automatically check and download the 

latest configuration files from the selected product information. The user will be notified when there are new configurations 

available for download.  

 Automatic streaming: When this is enabled, the ROHM EVK GUI will automatically start data streaming when the device 

stream is changed. (Figure 44) 

 COM port: Allows user to define the USB COM port. This can be used for example when multiple Host Adapters are 

connected or if “Auto connect USB” does not work. Note: this setting is enabled only if “Auto connect USB” is disabled. 

 Reset connection: Reinitialize connection to connected Host Adapter. 

 Reinitialize board: Resets the Host Adapter and applies “Confirm Board.” 

 Reconfigure product family: Opens dialog for changing Product Family or updating product information of the selected 

Product Family. (7.1.4.1) 

 Host Adapter Programmer: Tool for updating ROHM EVK Firmware. (7.1.4.2) 

 

Figure 13 Settings menu 

7.1.4.1. Reconfigure Product Family 

The “Reconfigure Product Family” menu item opens a dialog (Figure 14) for browsing and selecting different ROHM EVK product 

families. The dialog displays the available product families along with their update status in three columns.  

 “Product Family”: The name of the product family. 

 “Local Package”: indicates if the product family is already downloaded and available offline or it is not found locally. 

  This status indicates that the product family is found locally. 

  This status indicates that the product family configuration file is not found locally. 
 “Update Status”: indicates whether product updates can be downloaded and reflects the current internet connection 

status. 

  This status indicates that the corresponding product family configuration is up to date.  

  This status indicates that there is update available for the corresponding product family configuration.  
  This status indicates that there is no internet connection. 

  This status indicates that there is an error when checking for the update status 
 “Compatible": indicates whether the selected product family configuration is compatible with the current software version. 

  This status indicates that the corresponding product family configuration is compatible. 
  This status indicates that there is no internet connection. 
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  This status indicates that the product family configuration is not compatible. 

The current product family configuration section provides more information on the currently selected product family. This section 

provides the dates for both configurations and registers updated with their corresponding hash code.  

The five buttons:  

 “Select”: activates currently highlighted product family and uses Local Package even when update is available. 

 “Update”: activates currently highlighted product family and downloads the latest product information from the cloud if 

there is internet connection. The button is disabled if there is no internet connection or there is no update available. Note: 

there are cases where the firewall might block access to cloud services. In such cases, ROHM can provide offline updates. 

(6.2) 

 “Cancel”: Closes the dialog without changing the product family. 

 “Add”: button can be used to add a new configuration key (6.1) or a zip configuration (6.2)  

 “Delete”: button can be used to delete a configuration key along with its associated configuration. However, the currently 

active configuration cannot be deleted.  

 

Figure 14 Product family selection dialog 

7.1.4.2. Host Adapter Programmer 

The “Host adapter programmer” menu item opens a dialog for updating ROHM EVK Firmware. It is recommended to update the 

Firmware always to the latest one. EVK GUI SW will always check that the FW is compatible with the board selected (7.1.6) and 

informs if the version is not compatible. (Figure 31) Detailed instructions of the Firmware update procedure are explained in the 

Chapter 8 . 

NOTE: Firmware files are in folder %USERPROFILE%/Documents/ROHM_EVK/ROHM-EVK-Firmware/.  

7.1.5. Stream 

The “Stream” menu can be used to preconfigure applicable ROHM products to operate in certain modes. It can also be used to 

define how data is received or processed from the ROHM product and shown in the plotter. (7.7) This setup is named Data Stream. 

The list of Data Streams will change according to the chosen board. (7.1.6) Data Streams can show analog data like voltage level 

or binary data like GPIO state. 

7.1.5.1. Product example Data Stream from KXTJ3 

For example, if the RKX-EVK-001 / Accelerometer EVB / SPI board is selected from the “Board” menu, the KXTJ3 sensor will not 

be shown in the “Stream” menu because it does not support an SPI interface. However, when the RKX-EVK-001/Accelerometer 
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EVB/I2C board configuration is selected, the KXTJ3 sensor will be shown. (Figure 15) 

 

 

 

Figure 15 KXTJ3 wake up interrupt 

7.1.5.2. Product example Data Stream from BU79100G 

In the case of board menu selection “RKX-EVK-001 / ADC EVB”, stream menu provides the following options for BU79100G. 

(Figure 16) 

 

Figure 16 BU79100G streaming menu 

7.1.6. Board 

The “Board” menu is used for selecting the ROHM EVK HW that is going to be used. Some EVK HW are product specific, and 

some can be used for multiple products. In such case, the product can be selected from the “Device name” pull down menu. 

(Figure 36)  After Board is selected, user needs to visually verify from Product Information tab (7.5) that the selection is correct 

and then confirm the board selection with “Confirm board” button. (7.4.1) 

The “Board” menu lists all supported board configurations for all supported Host Adapters when “Show all board configuration” 

(Figure 18) is selected via the “View” menu. (7.1.7) Otherwise, the “Board” menu lists only the ones which are compatible with 

currently connected Host Adapter. For example, Figure 17 shows the case of RKX-EVK-001 with CY8CKIT-059 when the “Show 

all board configuration” is not selected.  
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Figure 17 The board menu when "Show all board configuration" is not selected 

 

 

 

Figure 18 The board menu when "Show all board configuration" is selected 

Naming convention of board menu item names has the following convention: 

 ROHM EVK Host Adapter name. 

 ROHM EVK Adapter Board name, if in use. 

 ROHM EVK EVB name, if board is EVB specific. 

 Communication interface, CRC mode etc. product specific parameters. 

7.1.7. View 

The “View” menu item provides distinctive features that can be shown or hidden in the ROHM EVK GUI SW. (Figure 19) 

 

Figure 19 View menu 

 Digital output in sub channel view: Shows numeric data from the plotter 7.7 in the Sidebar 7.4.2. 

 Events view panel: Show window where executed operations between the ROHM EVK GUI SW and the ROHM product 

are listed. (7.8) 

 Reference line: Display a horizontal line that the user can move or reposition in the Plotter. (7.7) 

 Show all board configurations: Shows all boards in the selected product family or only the ones which are currently 

connected Host Adapters supports. 

 Show ODR warning pop up window: Shows notification window if the output sample rate in the plotter is not what is 

expected. This phenomenon could occur if there are connectivity problems between the ROHM EVK GUI SW and the 
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ROHM product or with high data rates. (7.9) 

7.1.7.1. Product example KXTJ3 wake up Pop Up window 

For sensor evaluation, if selected stream contains accelerometer ASIC engine wake up or back to sleep function (7.1.5.1), then 

by selecting “Show wake up pop up window” (Figure 20) it is possible to show additional Pop-Up window (Figure 21) when the 

event is detected.  

 

Figure 20 View menu with Show wake up pop up window 

 

Figure 21 Wake up Interrupt pop up window 

7.1.8. Help 

From the “Help” menu it is possible to access ROHM EVK User’s guides as well as version information about the ROHM EVK 

GUI SW, ROHM EVK FW and when Product Family information has been updated. 

 

Figure 22 Help menu 

 User Guide: Opens the ROHM-EVK-Doc’s folder, where available User’s Guides are located. 

 Release Notes: Opens release notes text file, where details of the version release are explained. 

 About ROHM EVK: Shows information about ROHM EVK GUI SW and selected Product Family. (7.1.8.1) 

 About Host Adapter Board: ROHM EVK FW version number and ID number. (Figure 23) 

If reporting problems regarding ROHM EVK Platform functionality, it is good to include information provided in Figure 23 and 
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Figure 24.  

 

Figure 23 Host Adapter Board 

7.1.8.1. About ROHM EVK 

This view displays the version number of the current ROHM EVK GUI software. (Figure 24) 

The configuration information shows:  

 the current ROHM EVK GUI SW’s version number. 

 the date when it is downloaded to ROHM EVK GUI SW. 

 hash code of the product information. More information in Chapter 7.1.4.1.  

 the name of the currently selected product family.  

 

Figure 24 About ROHM EVK 

7.2. Title bar 

Title bar shows the ROHM EVK GUI SW version and the selected Product Family. If the product information contains confidential 

information, it is also indicated in the title bar. The same information can be found from menu “Help/About ROHM EVK”. (7.1.8.1) 

 

Figure 25 ROHM EVK title bar 

7.3. Status bar 

The status bar shows the following information: (Figure 26) 

 Current connection interface (USB / Bluetooth).  

 The status of communication (Streaming, Connected, Disconnected, No Data). 
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 Output Data Rate (ODR) of the Plotter data. (7.7) 

 Selected plotter stream. (7.7) 

 Selected evaluation board. (7.1.6) 

 

 

Figure 26 ROHM EVK GUI SW status bar 

NOTE: Calculated ODR value can vary from the actual ODR value since data is sent from ROHM EVK FW to ROHM EVK GUI 

SW in bursts which timing is controlled by the operating system. See also (7.1.7) and (7.9).  

7.4. Sidebar 

The Sidebar is on the right side of the ROHM EVK GUI SW window. (Figure 10) Sidebar holds both generic operations of the 

ROHM EVK GUI SW and possible product specific operations.  

Main components of the Sidebar are: 

 EVK status with board selection and confirmation operations. (7.4.1) 

 Numeric representation of the Plotter data. (7.4.2) 

 Product specific operations for the ROHM Product. (7.4.3) 

7.4.1. EVK status 

EVK Status-view holds information about the ROHM EVK Platform connection status and provides functionality to select and 

confirm ROHM EVK HW to be used. The ROHM EVK HW is selected from the EVK Status-view board pull-down menu. (Figure 

27) The pull-down menu content is same as “Board” menu content. (7.1.6)  

 

Figure 27 Board pull-down menu 

If there is no connection to Host Adapter, the EVK status is “EVK Disconnected”. (Figure 28)  
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Figure 28 EVK status-view in EVK disconnected state 

 

After connecting compatible Host Adapter, the status becomes “EVK Connected” and “Confirm board” button starts to blink. (Figure 

29) 

 

Figure 29 Status-view in EVK Connected state 

NOTE: In this phase it is important to check that the physical ROHM EVK HW corresponds to the image in the Product Information 

tab (7.5) and the electrical connection is done according to information accordingly. After this check, the ROHM EVK FW and 

ROHM product on the EVB can be initialized by pressing “Confirm board” button and the EVK status becomes “EVK Ready” 

(Figure 30). Now, ROHM EVK Platform is set up and ready to be used. 

 

Figure 30 Status-view in EVK Ready state 

If the ROHM EVK FW has not been updated for a while or if a custom version of the ROHM EVK FW is required for the ROHM 

EVK Host Adapter of the selected ROHM EVK HW, then the status will be “EVK Mismatch”. (Figure 31) The required ROHM EVK 

FW version can be found on the error_log.txt file which is on the root folder of the ROHM EVK GUI SW installation. 
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Figure 31 Status-view in EVK Mismatch state 

7.4.2. Plotter sub channel 

Sub channels of the selected Data Stream (7.1.5) are shown in Sidebar sub channel view. By toggling Sub channel name buttons, 

it is possible to select which sub channels Plotter (7.7) will show. If View/Digital output in sub channel view menu item (7.1.7) is 

selected, then numeric values of Plotter sub channel data are also shown.  

 

Figure 32 Sidebar sub channel view 

7.4.3. Side bar product specific functionality 

The sidebar can contain additional controls: buttons, sliders etc. which contain product specific input and output of the Host 

Adapter digital or analog input pins. Information about each functionality can be seen with tooltip help which is activated by 

hovering mouse over the control. 

7.4.3.1. Product example BD18397 Sidebar controls 

In (Figure 33), the Sidebar contains buttons for enabling and disabling BD18397 Watchdog functionality and sliders for controlling 

duty cycle of the Host Adapter PWM output. Additional information of any functionality can be shown by hovering mouse over 

controls. For example, in Figure 33 Tooltip window is shown for slider “CH1 ext. PWM”. 
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Figure 33 Product specific controls for BD18397 

7.4.3.2. Product example BD18333 

In Figure 34, the Sidebar contains Control for toggling Host Adapter GPIO output in state and status for monitoring Host Adapter 

GPIO input pin states. 

 

Figure 34 Product specific controls for BD18333 

7.5. Product information tab 

The product information tab is always activated when a new ROHM EVK HW is selected from the “Board” menu 7.1.6 and 7.4.1. 

This tab contains essential information about ROHM EVK HW. There is a reference image of the ROHM EVK HW and HW setup 

information. After the visual check and HW setup are done, the ROHM EVK Platform can be initialized for the ROHM EVK HW by 

pressing the “Confirm board” button from the Sidebar. (7.4.1) 

NOTE: if confirming incorrect ROHM EVK HW or if the HW setup is not done according to instructions there is a possibility of 

physical damage of ROHM EVK HW. 
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Figure 35 Product information tab 

7.6. Register editor 

“Register Editor” tab is shown for ROHM products which has internal registers. Register editor contains Register Editor Toolbar 

7.6.1 for common operations and the Register Editor View 7.6.3 for viewing editing register values of selected ROHM product. 

(Figure 36) 

 

Figure 36 ROHM EVK GUI SW register editor tab with opened device name pull-down menu 

7.6.1. Operations in register editor toolbar 

The Register Editor toolbar is the upper horizontal area of the “Register editor” tab. The following is the information about each 

operation: 

 “Device name” pull-down menu that shows all ROHM products which can be used with selected ROHM EVK HW. (Figure 

36) 

 “Register count” displays how many registers a currently selected ROHM product contains. 

 “Select set” pull down menu contains list of subsets of register space for the currently selected product. (Figure 37) 

 

Figure 37 Register set pull-down menu 
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 Polling view is for controlling continuous monitoring of register values. (7.6.2) 

 “Read all”: button reads all register values from the currently selected product to the Register Editor. 

 “Write all”: button writes all values from the Register Editor to the connected ROHM product. 

7.6.2. Register polling 

Register polling is a functionality for monitoring subsets of registers. In this way, it is possible to monitor the state of the ROHM 

product via registers. Polling can be started with the “Start” button and stopped with the same button, which during polling 

operation has text “Stop”. Polling interval can be defined in the corresponding numeric input box. Status column of register which 

value is changed turns from “Unchanged” to “Changed”. This may be difficult to detect, especially if the polling interval is short 

and value changes are not static.  

When “Auto stop” operation is enabled, the polling operation will stop immediately when any of the register values are changed. 

(Figure 39) This way it is easy to analyze register changes. 

NOTE: Register polling can be activated only if subset of registers is selected from the “Select set” pull down menu. 

 

 

Figure 38 Register polling function active 

 

Figure 39 Register polling auto stop 

7.6.3. Operations in register editor view 

Register Editor view is a common tool for editing register values of all ROHM products that have internal register map. Register 

Editor view has following columns: 

 Address: Register address as hexadecimal number. 

 Name: Register name. 

 Bin value: Register value as binary number. 

 Value: Register value as hexadecimal number. 

 Status: Status of the latest register operation. 
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 Read and Write: Buttons for reading the register value from the ROHM product to register editor and vice versa. 

 Register values: Register value shown as specified in the datasheet. 

7.6.3.1. Register Status field 

The register status field shows the status of the latest operation for the register. (Figure 40) 

Common statuses:  

 POR: After the new ROHM product is selected from the Device pull-down menu. 

 Edited: After editing the register value. 

 Read: After pressing the Read button. 

 Stored: After pressing the Write button. 

Error statuses: 

 Verify fail: If Verify Write (7.1.3) is enabled, the written value is checked against the read-back value.in case of mismatch, 

the status is Verify fail 

 CRC fail: if CRC check is in use, then CRC check is done for read operation. In case of mismatch, the status is CRC fail. 

 Error: Displayed if a read or write operation fails. 

Status values during Register polling are explained in 7.6.2. 

 

Figure 40 Register editor status values 

7.6.3.2. Register value viewing and editing 

Register values can be viewed and edited from the register value column. For read only registers the value can be only shown 

and for read / write registers, the value can be also edited. If the register is read only, then the “Write” button is disabled, and value 

fields are gray.  

Register values are shown according to the following value types: 

 Binary values are shown as check boxes. (Figure 41) 

 Enumerated values are shown as pull-down menus. (Figure 41) 

 Numeric values are shown as hexadecimal values in numeric input boxes. (Figure 42) 
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Figure 41 Binary and enumerated values in the register editor 

7.6.3.3. Editing numeric values 

Numeric values can be entered as in decimal or as in hexadecimal format. After editing, the value is always shown as hexadecimal. 

Allowed value range is shown in the header field of the value. (Figure 42) Numeric values can be modified with arrow up and 

down keys as well as page up and page down keys. 

 

Figure 42 Numeric values in the register editor 

Sometimes, numeric values are encoded to multiple registers. In such case, the whole value can be shown in a single register 

editor row which register address points to first address where the value is stored. The magnitude of the value can be seen from 

the header field. (Figure 43) 

 

Figure 43 Large numeric values in the register editor 

7.7. Plotter tab 

“Plotter” tab provides oscilloscope functionality for viewing information from the connected ROHM product. The data to be plotted 

is selected from the “Stream” menu (7.1.5). Plotter contains Plotter Toolbar for common operations (7.7.1) and the Plotter view 

(7.7.2) for viewing numeric values in graphical form. The data can be shown both on time domain (e.g., x-axis is time) or frequency 

domain (e.g., x-axis is frequency). The numeric values are shown on the right-side panel. (Figure 15) 

7.7.1. Operations in Plotter toolbar 

The plotter toolbar is the upper horizontal area of the “Plotter” tab. Toolbar has the following functionalities: 

 Streaming: start or stop data reading to plotter. 

 Data logging (red circle): start or stop storing data to a file. NOTE when logging is enabled the red circle icon starts to 

blink. 

 Raw data: toggle data to be shown as “counts” or SI-units. 

 Auto scaling: plotter will automatically zoom the y-axis according to the shown data. 

 Show grid: show or hide grid lines. NOTE: grid lines may slow down plotter performance. 

 Pause: temporarily pause the plotter, allowing you to capture or analyze specific moments in the real time data.  

 Clear: clears the plotter’s view. This can be useful if the x axis contains data from long time window. 

 FFT: toggle plotter between time and frequency domain. Frequency calculation is done with Fast Fourier Transform. 

 Data range: with the slider, it is possible to adjust the amount of data points shown in the plotter. NOTE: At high data 

rates, the slider area of Data Range may blink red. This indicates that all data samples cannot be drawn, and the data is 
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averaged. 

Plotter data has one or more channels. All of these can be divided into subchannels. The purpose of the channels is to divide data 

into logical groups. Each channel is shown as a button on the right end of the plotter toolbar. Subchannels of each channel are 

listed in the Sidebar. (7.4.2) By hiding uninterested channels or subchannels, it is possible to focus only on the data which is under 

current interest. 

 

 

Figure 44 Plotter toolbar 

If FFT mode is selected the plotter toolbar has options for selecting linear or logarithmic X and Y axis. 

 

 

Figure 45 Plotter toolbar in FFT mode 

 

7.7.2. Plotter view 

Plotter view shows graphical data from the data stream selected from “Stream” menu (7.1.5)  according to settings done in the 

plotter toolbar (7.7.1) and side bar. (7.4.2) 

The following operations are available from the plotter view: 

 Zooming: zoom in/out can be accomplished using mouse scroll wheel or right mouse button + CTRL. 

 Panning: y-axis can be panned by pressing the right mouse button and moving the mouse. 

 Reference line: If reference line is enabled from (7.1.7) it can be moved by clicking it with the left mouse button and 

moving the mouse. The numeric value of the reference line Y-axis position can be seen from the status bar. (7.3) 

Notes on Frequency Analysis: 

 The “Stream” menu (7.1.5) usually contains data with different data rates. Suitable data rates should be selected for 

frequency analysis since the frequency range is always up to ODR/2 Hz.  

 The frequency of detailed data points can be seen by clicking the left mouse button over the plotted line. 

 The logarithmic Y axis shows the frequency data in decibels. 

7.7.2.1. Product example Frequency plot of BU79100G data 

 Select the board RKX-EVK-001 / ADC EVB from the “Board” menu. 

 Select BU79100G / ADC data (VA=3.3V, 10kSPS, non-inverted) from the Stream menu. 

The plotter should now display real time output for ADC. (Figure 46)  
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Figure 46 FFT plot with RKX-EVK-001/ADC EVB 

7.7.3. Product example KXTJ3 wake up detection 

The KXTJ3 wake-up detection streaming can be selected using RKX-EVK-001/Accelerometer EVB/I2C board configuration 

(7.1.5.1) by selecting Wake-up Detection 50Hz (default) streaming. (Figure 47) 

 

Figure 47 KXTJ3 wake up streaming 

The wake-up pop-up window (Figure 15) appears for selected wake-up / back-to sleep event detection streams. (Figure 47) When 

a wake-up event is detected, the pop-up window is displayed in the plotter. (Figure 15) 

7.8. Event view panel 

The Event View panel is in the bottom part of the ROHM EVK GUI SW window, if it is enabled from the “View” menu. (7.1.7) Event 

view panel shows time stamped communication events between the ROHM EVK GUI SW and the ROHM EVK Host Adapter. This 

includes for example register read and write operations. Operations listed in the event view can be saved to a JSON file by clicking 

the “save” button in the top right corner for later analysis.  

 

Figure 48 Event view panel 

7.9. Pop-up windows 

The ROHM EVK SW GUI uses pop-up windows for providing status information or other information. These pop-up windows can 

be in several locations: 

 pop-up windows are used to notify the users about important actions. For example, the ODR warning pop-up window 

appears anytime when the real time ODR as measured by the ROHM EVK GUI SW is significantly different from the 

normal ODR set in the stream.  
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Figure 49 ODR information window 

 Tooltips: Most of the ROHM EVK SW GUI elements, including buttons, menu items, register editor fields, and sidebar 

operations have tooltips which provides additional information about the functionality. The tooltip window can be shown 

by hovering the mouse over the location of interest. 

 Toast windows: After time consuming operations like product information download, the toast window is shown on the 

lower left corner of the Windows menu bar. 

7.10. Keyboard shortcuts 

CTRL + L Enable/disable logging 

CTRL + S Enable/disable streaming 

CTRL + R Reset used connection and data streaming (disconnect and connect when having connection 
problem). Re-enable the Streaming when connection is established. 

CTRL + E Hide/Show events view 

CTRL + D Hide/Show digital output in sub channel view (works only if subchannel view is enabled) 

C Clears the current points in plotter view 

CTRL + B Enable/Disable Show all board configuration 

CTRL + O Show ODR warning pop up window 

G Shows the grid in the plotter   

P Pause plotter 

CTRL + W Hide/show wake up interrupt pop up window 

SHIFT + L Hide/show reference line 

CTRL + SHIFT + D Register dump 

CTRL + SHIFT + V Enable/Disable Verify write 

CTRL + SHIFT + B Reinitialize board (re-execute board initialization messages) 

 

8. ROHM EVK firmware 

Several MCU boards can be used as a Host Adapter in the ROHM EVK Platform and can be programmed using the ROHM EVK 

GUI host adapter programmer tool. Installing the firmware using the host adapter programmer tool requires that the host adapter 

board includes the ready-installed EVK firmware. Host adapter board is detected by the programmer if already installed. Details 

of instruction on how to update firmware using the host adapter can be found in 8.1.  

The MCU board that can be programmed using the host adapter programmer are:    

 CY8CKIT-059 by Infineon 

 Adafruit Metro M4 by Adafruit Industries 

 Pico and Pico 2 by Raspberry Pi foundation 

Additionally, ROHM EVK firmware is provided for the following MCU board.  

 

https://www.infineon.com/cms/en/product/evaluation-boards/cy8ckit-059/
https://www.infineon.com/cms/en/
https://www.adafruit.com/product/3382
https://www.adafruit.com/
https://www.raspberrypi.com/products/raspberry-pi-pico/
https://www.raspberrypi.com/products/raspberry-pi-pico-2/
https://www.raspberrypi.org/
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 Arduino UNO R3 by Arduino. 

 nRF52-DK by Nordic Semiconductor. 

For these host adapters, the firmware update procedure is different. The firmware update procedure for these MCU boards is 

explained in 8.2.   

8.1. Host adapter programmer detects the device 

The firmware programmer tool with graphical user interface is provided for most common host adapter boards. The tool can be 

launched from “Settings” menu. (7.1.4.2) 

Firmware update for CY8CKIT-059 can be done with the following steps when ROHM EVK GUI SW is running: same steps can 
be applied to other devices such as Adafruit Metro M4 and Raspberry Pi devices.  

 Connect the host adapter board to the PC. (Figure 4) 

 Wait for the EVK status to become “EVK Connected” or “EVK Mismatch.” 

 From the “Settings” menu, select Host adapter programmer. (7.1.4.2) 

 Wait for the programmer to start and for the status to become Connected. (Figure 50) 

 Press the “...” button to select a firmware image file (Figure 50). Firmware image files are in 

the %USERPROFILE%/Documents/ROHM_EVK/ROHM-EVK-Firmware/CY8CKIT-059/ directory. It depends on the 

host adapter which directory to choose.   

 Press “Program” button to load the Firmware into the host adapter. 

 Wait for the programming to be completed and for the status to become successful. (Figure 51). 

 Close the ROHM EVK Programmer from the upper right corner “X” button. 

NOTE: if the Metro M4 is not detected, double press is needed to enter detection mode. 

NOTE: Raspberry Pi Pico is always delivered with preinstalled firmware. If the Raspberry Pi Pico is not detected with the host 

adapter, please contact FAE.  

 

Figure 50 Firmware programming start / CY8CKIT-059 

https://docs.arduino.cc/hardware/uno-rev3/
https://www.arduino.cc/
https://www.nordicsemi.com/Products/Development-hardware/nRF52-DK
https://www.nordicsemi.com/
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Figure 51 Firmware programming done / CY8CKIT-059 

8.2. Host adapter programmer doesn’t detect the device 

8.2.1. Firmware update procedure for CY8CKIT-059 

For a CY8CKIT-059 MCU board that does not yet have a compatible version of the ROHM EVK Firmware, the initial update must 

be performed using the Infineon PSoC Programmer tool. This procedure needs to be done only once, provided that the ROHM 

EVK Firmware has not been previously flashed. After the initial flashing, all subsequent firmware updates can be done using the 

"EVK GUI SW Host Adapter Programmer." 

 Download and install PSoC Programmer application from 

https://softwaretools.infineon.com/tools/com.ifx.tb.tool.psocprogrammer. 

 Connect the CY8CKIT-059 into the USB port of the PC directly or with USB extension cable A-Male to A-Female to the 

PC.  

 NOTE: Make sure to use the USB port for firmware flashing.  

 Image files are in directory %USERPROFILE%/Documents/ROHM_EVK/ROHM-EVK-Firmware/CY8CKIT-059/. The 

image files are in. hex format  

 Open the PSoC programmer application on your computer. Once opened, verify that “Powered” and “Connected” status 

messages are seen.  

 If you receive the Warning messages such as the programmer is not up to date, use the “Upgrade Firmware” button for 

installing latest firmware to the programmer. 

 Select image file by using the “Open Folder” button. 

 Program the firmware into CY8CKIT-059 by pressing “Down Arrow” button. 

 If the programming was successful, the message is seen in the “Results” window. 

8.2.2. Firmware update procedure for Arduino UNO R3 

Firmware update for Arduino UNO R3 can be done with the following steps when ROHM EVK GUI SW is not running: 

 Download the avrdude zip package (Windows) from the avrdude official website: 

https://download.savannah.gnu.org/releases/avrdude/avrdude-6.4-mingw32.zip 

 Connect the Arduino UNO R3 into the USB port of the PC. 

 Open a command prompt to the %USERPROFILE%/Documents/ROHM_EVK/ROHM-EVK-Firmware/Arduino/ directory 

and execute arduino_flash.bat.  

 Follow the instructions of the .bat file. 

 

https://softwaretools.infineon.com/tools/com.ifx.tb.tool.psocprogrammer
https://download.savannah.gnu.org/releases/avrdude/avrdude-6.4-mingw32.zip
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8.2.3. Firmware update procedure for nRF52-DK 

Firmware update for nRF52-DK can be done with the following steps when ROHM EVK GUI SW is not running. 

 Set nRF52-DK “Power source” switch to VDD and the “nRF” switch to default. Turn “Power” switch On and connect the 

nRF52-DK into the USB port of the PC.  

 NOTE: There are two USB ports on the board so make sure not to use the nRF USB port for programming. 

 After USB connection, the JLINK drive should be visible in the file explorer. 

 The NRF52-DK image file is in the directory %USERPROFILE%/Documents/ROHM_EVK/ROHM-EVK-

Firmware/nRF52840-DK/. 

 Drag and drop the image file to the JLINK drive. 

 LED blinking animation should be seen after successful programming. 

 

 

9. Troubleshooting 

In case of connection problems or an application crash, please check the error log file of the ROHM EVK GUI SW. The default 

path of this file is ../Documents/ROHM_EVK/ROHM-EVK-GUI/errorlog.txt.   

9.1. Communication troubleshooting  

9.1.1. Host adapter communication issues  

The communication between the ROHM EVK GUI SW and the host adapter may not work for several reasons. The issue can be 

related to hardware, software, or both. The following steps can be used as guidance to troubleshoot such issues. 

9.1.1.1. “Status: EVK Disconnected” in ROHM EVK GUI SW status bar 

 

 

Figure 52 Status bar, Disconnected 

This status means that the ROHM EVK GUI is not connected to the host adapter board. If the host adapter is connected but the 

status is disconnected, you can check the status and settings from the host adapter board. 
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Figure 53 ROHM_EVK_001 status LED1, SW4, LED2, LED1(CYCKIT-059) must be on 

The blue LED1 (CY8CKIT-059) should be constantly ON and not blinking. (Figure 53)  

 If the blue LED1 (CY8CKIT-059) is blinking, the CY8CKIT-059 is not programmed with the ROHM EVK FW. Please 

program the latest ROHM EVK FW. See (8.2.1) for details.  

 If the blue LED1 (CY8CKIT-059) is turned off, please try the following:  

 Check that the micro-USB cable is securely connected to the CY8CKIT-059 prototyping kit and to the USB port on the 

PC.  

 Connect to a different USB port on the PC. 

 Replace the micro-USB cable with a new, high quality, USB certified cable.  

Green LED1: (Figure 55) 

 If the green LED1 is OFF but the blue LED1 (CY8CKIT-059) is ON: 

 Ensure the CY8CKIT-059 prototyping kit is securely connected to the RKX-A3-EVK-001.  

 

9.2. “EVK Mismatch” – state with the ROHM EVK GUI SW 

This error means that the firmware version is not compatible with the board configuration. Make sure that HW, board configuration 

and firmware versions are compatible. 

For example, if the “EVK Mismatch” pop-up window appears you should check the “errorlog.txt”. If you can find the following text 

in the errorlog.txt:  

#######################  

[ERROR] EVK Mismatch - state detected:  

“board_04ADC_10_RKX-EVK-001_spi_0” does not support the protocol version (2.0) of the firmware.  

Supported protocol versions in board config: [  

"2.4",  

"3.1"  

]  

######################## 
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9.3. Known issues 

 If you have a previous ROHM EVK GUI version installed already, make sure to close it before running the installer. (5.1) 

 To have the best user experience, it is recommended to use a display resolution of not less than 1920 x 1080. 
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